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Established in 1944, the Victoria Camera Club is a group
of people who share the love of photography. We come
together to appreciate each other’s images, to learn, both
from the feedback on our own images and from the images of others, and to exchange tips on how and where
to take effective photographs. Our focus is on continuous
learning. Our media include both film and digital and our
expertise ranges from novice to master.

Events
We hold a number of events including:
• Three meetings a month from September to April
(excluding December)
• Field trips
• Workshops
• Special Interest Groups (SIGs)
• Competitions within the Club and externally
Meetings begin at 7:30 PM at Norway House, 1110 Hillside Avenue, Victoria, BC.

Membership
Annual fees include all workshops (except studio shoots
and special events), meetings and all field trips unless
travel/accommodation is involved. Annual fees are: Individual, $85; Family, $128; Student, $43.
For current event information and locations please go to
the website victoriacameraclub.ca where you can also
read or download the colour version of Close-Up.
PSA Award-winning Website and Newsletter
2011, 2012, 2013, 2014, 2016, 2017, 2018 and 2019
CAPA Award-winning Newsletter 2015

Close-Up is the magazine of the Victoria Camera Club.
Copyright ©, Victoria Camera Club, 2020, all rights reserved. Mailing address: PO Box 46035, RPO Quadra,
Victoria, BC, V8T 5G7. Editor, Richard James, (editor@
victoriacameraclub.ca) for submissions or advertising
in Close-Up. Deadline for submissions for the August/
September 2020 issue is July 1st.
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Calendar

President’s Message

Our workshop and field trip program is too extensive
to list in Close-Up. Please go to the calendar page on
the website (www.victoriacameraclub.ca) for the latest
details of all our workshops, field trips and meetings.

What a difference one month can make. Last month, I
wrote about our upcoming AGM. Little did I know that,
instead of having our AGM at the usual Norway House
meeting, we would have to find a way to have it virtually and that all Club meetings, workshops and field trips
would be cancelled for the foreseeable future. I am also
keenly aware that from the time that I write this message
to when it is actually released, there will be many more
changes to our lives due to the Covid-19 pandemic.

All meetings, workshops and field trips are cancelled
until further notice due to health precautions.
Hopefully, we can resume our schedule in September. Please check the website for updates when restrictions allow meetings again.
Ted Grant:1929-2020. Renowned Canadian photojournalist, Dr. Ted Grant, OC, passed away April
18th in Victoria. Known for many newsworthy images including his image of Pierre Trudeau sliding
down the banister at the 1968 Liberal Party convention in Ottawa, his series of medical images shot in
Ottawa, Victoria and other hospitals as well as his
image of Ben Johnson crossing the Olympic finishing
line. Ted used his trademark Leica almost daily and
enjoyed meeting with a small group of print-makers
until early this year.
Cover Image: “An Easter Toast” by Alison Poole. I am
often drawn to my camera to photograph something indoors on a rainy day. Lately it has not been the rain keeping us indoors, but that is another story. This photograph,
in landscape orientation, was posted to the Covid 19
Distraction Project, Easter edition. Our Close-Up Editor,
Richard James, thought he would try it on the cover. With
my permission he gave it a wee flip vertically tossing one
of the eggs from the martini glass in the process!
The decorative eggs, commonly known as Ukrainian
Easter eggs, are referred to as pysankas by their creators. Three were decorated by my daughter Alanna
when she was in grade one, back in the mid-1990s.
The other two were a gift to my mother from a dear
Ukrainian friend of mine.
The photo was taken a few years back with my old Nikon
D7000. Placing a black fleece blanket on the table I set
the scene. The lens used was an AF-S VR Micro-Nikkor
105 mm f2.8 G IF-ED. I used a tripod. My manual settings were f11, 1/6th second, ISO 200 and I bounced my
Nikon SB 900 TTL flash off the ceiling.
I have a lot of fun with this type of indoor photography.
In the last edition of Close-Up, April 2020, my “Hibearnation” photograph on page 13 was taken in much the
same way. Give it a try; you will no doubt have lots of
time to explore new possibilities yourself.
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I am missing our meetings that are all things social
where we can connect with friends and catch up on the
latest news. One of the questions on everyone’s mind is:
“When is this all going to end so we can get back to getting together and take photos or learn at our many workshops?” I am unable to answer this question but urge all
members to heed our governments’ advice and look forward to when all of our efforts will help flatten the curve.
In the meantime, our virtual AGM has been done and
we will continue to plan for our future. Our executive has
been conducting our meetings virtually as well and our
next meeting will be the handover to the new executive.
Many thanks to John Clarke, our outgoing Treasurer,
and Grant Hughes, our outgoing Member-at-Large. Their
contributions to the Club have been greatly appreciated
and we wish them well. The new executive is:
•
•
•
•
•
•
•

President – Teri VanWell
Vice-President – Dan Takahashi
Vice-President – Penny Authier
Treasurer – Robert Law
Secretary – Susan McRae
Member-at-Large – Jill Turyk
Member-at-Large – Kim Smith

While we wait for the time when we can get together
again, there are many things that you can do at home
or in a safe space outside practicing social distancing.
For starters, there are many online courses that you can
take through YouTube, Lynda.com (free with a GVPL
card at gvpl.ca), CreativeLive or Kelby One. Some are
free but all allow you to learn some new skills in the
world of photography. How about putting together your
own workshop to share with members? Then there is the
Distraction Project that Lorna Shaw has put together for
members. A weekly themed project that members can
work on and post their images on our website.
Whatever your plans are, stay safe and healthy.
Teri VanWell, President

Close-Up

Long Exposure Effect: Using Multiple
Exposures
by Kirk Schwartz
Landscape photographers love long exposures, using
them to create creamy-smooth water and feathery motion-blurred clouds. Most often, to get a long enough exposure time, you need a Neutral Density (ND) filter but
you can get a similar effect by shooting multiple exposures of the same shot and combining them in Photoshop.
For best results you should use a tripod and a remote
shutter release or an intervalometer. The more shots
you take, the better the final blend will be but the harder it will be for your computer to process all the images.

“Merging the Images”
computer might not think it’s that small a step). Next
you will select “Layer>Smart Objects>Stack Mode>
Mean” and, voilà, your final product is ready for you to
export for the pleasure of the photographic world.
Here are a couple of links for you to explore for more
explanation and detail:
• FStoppers:fstoppers.com/education/using-long-exposures-without-help-neutral-density-filters-345545

“One Image from Sequence”
First, develop your RAW image and sync the settings to
the images in your sequence. I use Adobe Camera Raw
and Bridge rather than Lightroom, but it’s your choice. If
you use JPEGs you might not get the same image quality.
You need to open the images as layers in an image stack
in Photoshop by selecting “File>Scripts>Load files into
Stacks”. If you have loaded the images as individual tabs
in Photoshop select “Add Open Files” in the dialogue box.

• Mark Duffy: youtube.com/watch?v=2ig5LiZ1P5E
• Adobe Photoshop, using image stacks: helpx.adobe.com/photoshop/using/image-stacks.html
• Two ways to hack long exposure by Joshua Cripps
Photography: youtu.be/amC606SLxCg
And, finally, now that you have mastered this technique, take a look at this final photo. You can try using
the other stack modes for creative oddities and effects.

Unless your tripod was super steady or if you were trying to shoot hand-held, you need to align the images.
Choose “Edit>Auto-align Layers”. Now, with all layers
selected, right click or control click and choose “Convert
to Smart Object” from the pop-up menu.
Unless you have a fast computer go fill up your coffee cup. This is hard work for the computer so don’t
be surprised if it takes a bit and your computer’s fans
come on. Once your computing friend and companion
has finished converting the stack to a smart object,
you have only one small step remaining (though your
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A Camera in Your Pocket
by Daniel A. Roy
As another hobby I write science fiction stories, delving into my imagination to create tales about how our
lives might be affected by the ever-escalating changes
in technology. Most of my writings take place many
hundreds of years from now but this story touches on
technical applications that will be available in the next
five to ten years. This article has been written mostly to
entertain but, hopefully, it will also invoke a degree of
wonder, prompting you, the reader to imagine what life
might be like in the very near future.
This past summer I observed a young man capturing
“street” images in the heart of downtown. Even a novice could see that he was using some pretty expensive
gear. We struck up a conversation and he told me that
the lens alone cost him over two-thousand dollars. “It’s
all about the glass, man,” he said, as he snapped an image of a woman dressed entirely in yellow. She was window-shopping along the other side of the street, totally
oblivious to the fact that she had been photographed.
He chimped the capture and showed me the result. I was
impressed and told him so. The photographer handed me
his card and I have since viewed his website. Again, I was
impressed, astonished at how proficient a twenty-something photographer could be. However, while Googling, I
fell into a rabbit hole and happened upon another young
professional street shooter whose images were entirely caught with the use of his smartphone. Unsurprising,
the pics weren’t as “crisp” as the ones taken with the expensive gear but the mood of the smartphone images
were much more personal and, in my opinion, superior,
each stimulating my imagination and urging me to linger
a while longer.
What are the more obvious elements of a good photograph? Subject, composition, perspective, lighting, contrast, and (unless you are shooting black and white) colour. In order to capture a digital image, do any of these
elements require a camera with a full-frame sensor? No,
not unless the photographer intends to produce a print of
considerable size or to have that image scrutinized by a
panel of judges for a fine arts photography competition.
However, as manufacturing companies continue developing smaller and smaller elements that produce sharper and sharper details through increased pixel density
and improved optics, the quality gap between an expensive full-frame camera and a smartphone will decrease.
And, I’m going to step out on a limb and state that the

6			

gap between them will someday become so minuscule,
the measure will be irrelevant. Please take a moment to
mark this date on your calendar. By September 2025,
a smartphone will produce an image virtually equal to
that of a full-frame camera using the same or similar
post-processing methods.
Some might say this idea is pure fantasy but, I assure
you, it’s not. It reminds me of a quote I heard many
years ago in reference to all the manufacturing companies that continued producing typewriters at that point in
time, “You’d think they would have seen the typewriting
on the wall.” So, if you are thinking of purchasing a new
full-frame camera, or even one with a smaller format,
you may want to hold that thought and wait another year
or two. I would also encourage the big camera companies to invest in the smartphone markets.
Artificial Intelligence (AI) is a thing. It exists. Not yet a
true AI as I envision it, but the term is widely accepted.
Your camera and lenses (assuming your gear is reasonably current) already utilize this technology: autofocus, autoexposure, image stabilization and tracking,
to mention only a few, all these features are married to
our computers and software.
AI is the process of identifying commonalities and differences amongst a data set that lead to specific outcomes. Some are easy, almost trivial, such as getting
the exposure right. That is simply ensuring that the highlights are not blown out and that there is sufficient detail
in the shadows. Others are more complex such as is
the depth-of-field adequate? Measuring depth of field is
trivial but what does “adequate” really mean? It depends
on the subject and how you wish to interpret it.
Perhaps the most complex area in photography is determining how “good” an image is. How do we define good?
Does the composition comply with some predetermined
rules (rule of thirds, for example)? This is easily done but
does it produce a truly good image? Are the rules the
same for different uses of the image? Does a “fine art” image have to obey the same rules as an image produced
for an advertisement, or for a photographic competition?
The danger with rules is that they reduce everything to
a lowest common denominator. To be successful they
have to allow for innovation and, even lead it.
Once a “true AI” is available, you will no longer need
to mouse or to type a query or spend hours searching
through files on your computer. You will only have to
utter a phrase as simple as: “Winston, please choose a
series of images for next week’s Members’ Night. And,
Winston…” “Yes, Daniel?” “I want to hear nothing but
oohs and aahs throughout the entire presentation.”

Close-Up

Housebound Photography
by Pam Irvine
There is a lot you can do with photography while you are
stuck at home. Practice your fast/slow shutter speed by
photographing the dog or cat or, try panning (moving the
camera with your moving subject). Try some rim lighting
(light from the side or back) to emphasize the fur.
Lightbox: You could build yourself a light box and practice your still life and macro photography.

ator’s pass (annual pass) that allows you to watch all
of their hundreds of workshops on a wide variety of
topics. One subject I was interested in was “Where to
find inspiration”.
Lindsay Alder and Brooke Shaden, producers of one of
the classes, spent some time comparing their individual creative processes:
Lindsay said, “Creativity isn’t luck. Inspirations doesn’t
come from thin air.”
Brooke said, “I will not wait for inspiration. I will search
for it. The first step to finding inspiration is to be willing
to fail.”
Their suggestions on how to search for inspiration included looking at the works of other artists. Analyze
their work and identify what it is that speaks to you, perhaps the use of lighting or the colour palette. Then take
those concepts and use them to create your own vision
in your own style.

“Simple Lightbox”
To build this lightbox I cut holes in three sides of a
good-sized sturdy cardboard box. I then reinforced the
edges of the box with duct tape and covered the holes
with tissue paper as a diffuser. A grey or white piece
of curved poster board is held in place with clips and
gives a seamless background.
With a setup like this you can really practice your lighting
skills, paying attention to the reflections on your object
and shadows created by the placement of your lights.

Another suggestion was to write down a theme or one
word about something that you love or enjoy. Then write
down all the words that come to mind that you associate
with your original word. It could be a list that includes,
colours, flowers, movies, songs, or anything. Then do a
Google search on these words and see what fascinating
images come up on the screen to inspire you.
Creativity doesn’t stop at the click of the shutter, it continues into post-processing. Practice a new technique
and push it to the limits. You never know what you are
going to create until you try, maybe a photo of strawberry-red lips created with layers and blending modes
in Photoshop Elements.

Still Life Photography: Still life is a work of art that
focuses on inanimate subjects. Usually, the subjects
are commonplace objects.
When creating a still life photograph you need to find
ways to make your subject visually interesting. By experimenting with different arrangements, lighting, and
compositions, still life photographers can breathe life into
their subjects. That makes it a great genre to experiment
with and it can help you become a better photographer.
Creativity and Inspiration: During this period of home
isolation, I have been watching a number of photography workshops. Creativelive.com is filmed in Seattle,
offers a free workshop every day and also has a cre-
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Adjust Your Monitor!

ments on some monitors, so Standard mode may be a
better option.

by Doug Neal

A laptop computer may not have “monitor” adjustments
but the video card utility software may offer similar settings (if available).

Many of us do not have a monitor calibration device
but find printed images consistently come out dark or
off-colour. If so, you need to adjust your monitor settings
using the monitor menu options. You may also need to
use free or built-in software so that the on-screen image
more closely matches a quality print from a good lab.
To do this you will need a quality print of a digital test chart.
Download the sRGB version of this chart from olantra.
com/testchart.zip (original article at outbackphoto.com/
printinginsights/pi048/essay.html). A matte finish print is
best. Prism Imaging has offered to print a 5x7 sample of
it for $2 and The Print Lab has offered to provide a print
of the chart at no charge to VCC members!

Standing near the test print, look back and forth between the monitor and the print comparing overall darkness and contrast. Start with the brightness setting on
the monitor and try combinations of brightness and contrast to minimize the difference between the on-screen
and printed version of the image. Try standing back further and closing your eyes for a rest occasionally to get
a fresh impression.
On the test chart, below the numbers near the bottom,
are faint grey squares inside both the black and the
white background. Adjust brightness and contrast so
that at least half the grey squares are visible against
each background.
If the central B&W image of the test chart on the monitor seems to have a colour cast, possibly less “warm”
than the print, then you may need to make small adjustments to the RGB colour settings on the monitor (if
available) to attain a grey tone similar to the test print.
For instance, reducing blue in the monitor settings will
“warm” the image with yellow.
Windows and Mac computers both have a simple display calibration utility built into the operating system.
The main benefit is to set the Gamma, which adjusts
how dark mid-grey tones are. Search your settings for
“Calibrate Display” and follow the instructions.

No print will exactly match a monitor but general brightness, contrast, and mid-grey tones can be adjusted to
reduce differences.
You will also need a desk lamp with a 60-watt equivalent daylight LED bulb (5000K to 6500K) for evaluating
the print. The test environment should be as follows:
• A dimly-lit room.
• Desk lamp facing down onto four sheets of white
paper arranged in a rectangle with the test print in
the middle.
• Your monitor should be on for 20+ minutes to stabilize the output and be positioned 1.2 to 2 meters
away from the test print. Turn and angle the monitor to be square to your viewing position.
• Display the test chart full screen on the monitor.
Before you begin, select sRGB or Standard mode in
the monitor settings. sRGB will not allow further adjust-
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For Windows the free utility QuickGamma (quickgamma.
de, click on the language button) is an easy way to adjust the overall Gamma and the Gamma for individual
colours allowing you to remove colour casts as well. It
creates a monitor profile and associates it with your monitor so this may undo the changes made using Windows
calibration or other calibration tools.
If you want to delve deeper, the website agom.nl/lcd-test
offers several monitor test images and detailed notes on
the topic but I suggest keeping it simple using the procedure I’ve described here.
If your adjustment is correct your prints should come out
looking closer to the screen image. You can tweak these
settings as you compare future prints with the monitor
but don’t focus on a single print or a specific colour if
other prints generally look good. When you’re at that
stage it may be time to buy a calibration device!

Close-Up

Tech Tips: What is ETTR?
by Richard James
“Expose to the Right” (ETTR) is a technique to maximize the amount of information recorded in any image.
It is not new, it was introduced by Michael Reichman
in an article on his website, Luminous Landscape, in
July 2003 (luminous-landscape.com/expose-right) and
reviewed again in July 2011 (luminous-landscape.com/
optimizing-exposure).
In last month’s article, “The Science of ISO”, the key
point was that if the light level in the shadows is below
a recordable amount then there is no way of recovering
information by boosting ISO.

“Normal Metered Exposure”
In this histogram the camera meter exposure was used
and you can see there is a gap on the right-hand side
of the histogram where the highlights do not reach the
edge of the scale.

This is a brief explanation so some things are probably left for you to explore further. I am also assuming
that you are saving RAW images with the intention of
post-processing them. If you are shooting out-of-camera JPEGs and don’t intend to work on them then this
technique may not give you a close representation of
the scene.
Your camera’s exposure meter is calibrated to reproduce
a mid-range neutral grey and give you approximately
three stops of headroom before the pixels become saturated and cannot record any additional information in
the highlights. Notwithstanding the extensive intelligence
built into modern cameras the suggested exposure is
often not optimal.
The examples usually offered are a white snowshoe
hare in a snowfield and a black cat in a coal bin. In both
cases the exposure will tend towards neutral grey which
is clearly wrong in both cases. Compared to the meter
reading the hare/snowfield image needs overexposure.
But in the digital world, to capture the most data from
the cat/coal bin image it needs even more exposure
relative to what the meter suggests. This paradox is because digital images record half of the data in the top
f-stop, decreasing by a factor of 2 for each lower increment in f-stop.

“ETTR Exposure”
In the second histogram the exposure has been adjusted
so that the highlights are almost overexposed and more
detail in the low light values is retained.
To be successful with this technique you need to set the
in-camera JPEG settings to neutral values as the histogram and image on the LCD panel are using the in-camera JPEG not the RAW file data. With this caveat in mind
you can adjust the exposure until one channel of the RGB
histogram is almost touching the edge of the display. You
can also use the highlight warning to show where this is
happening. It is critical to use the RGB histogram, not the
luminance (white) histogram, as that is an average and
will hide overexposure in a single channel.

The concept is simple. Set the exposure so that the
highlights are just not overexposed. Then, in post-processing adjust the image so that all tones fall within the
range that they should be in the scene.

When you are learning this technique, it helps to review
the RAW image data using a tool like RawDigger (rawdigger.com) or FastRawViewer (fastrawviewer.com) that
show the RAW data rather than the converted values
in the image. You can see if you have any extra room
available to increase the exposure slightly compared
with what the JPEG data is showing in your camera.

What this does is ensure that the highlights are captured as well as capturing as much detail as possible
in the shadows before you hit the noise area and unrecordable light values in the shadows.

Once you have mastered the technique you will find that
you have much more data available in the shadow and
low light areas in your images. Now your challenge is to
manipulate this data in your post-processing.
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October Theme: “Arches, Alleys and
Laneways”
by Lorna Zaback
This theme probably doesn’t need a lot of explanation.
Architectural images, street photography, and landscape
shots highlighting narrow country roads would all fit in
this topic.
It is possible that, over the next few months, our chances of capturing images like these intricately sculpted
arches at the Louvre in Paris, or any of the magnificent
rock formations in the southwestern US, will be slim.

March 2020 Competition Judges
We sincerely thank our external judges for the March
Intermediate and Advanced level competitions, Christina Craft, Dan Jones, Sheena Wilkie, Gregg Eligh, Rick
Leche and Mike Byrne. We also extend thanks to our
in-house Novice Judges: Pam Irvine, Lorna Zaback, Jill
Turyk, Nicci Tyndall and Richard Webber. Images and
judges’ comments are available at: victoriacameraclub.
ca/Competitions/CompetitionResults.aspx.
Christina Craft: Digital Wildlife. Christina started FunkyTown Photography in 2008 focusing on portrait and wedding photography and has won international and Canadian awards. She has a master’s degree in journalism
specializing in documentary and broadcast news. She
won the best overall student award at the Western Academy of Photography and eventually joined the faculty.
Dan Jones: Digital Open. Dan has been a member of
the Camera Club of Ottawa for 23 years where he has
achieved the level of Master Photographer. He is a parttime professional photographer. His work includes stock
photo fine art prints, and he enjoys judging for a variety
of photo clubs.
Sheena Wilkie: Digital Theme. Sheena Wilkie is an enthusiastic participant in the global photography community. She is a passionate fine art photographer who enjoys
sharing her knowledge and expertise with others. Sheena
has been giving presentations and teaching photography
and software courses for over fifteen years.

“At the Louvre”
However, arches are familiar architectural features in Victoria, in churches, at the BC Legislature, at Craigdarroch
Castle or the Empress Hotel, for example. Or, check out
rose arbours or grapevine pergolas in the many gardens
around the area.
Alleys are also common in Victoria, some of the most
intriguing being in Chinatown. If you are contemplating shooting in Fan Tan or Trounce Alleys, possibly a
couple of the most photographed sites in the city, go
ahead, but maybe try for something different, a compelling street scene or an altered reality composition.
Laneways, winding and possibly tree-lined, through any
of the region’s parks or public gardens are also fair game.
For location ideas, check out “Favourite Sites for Photography” on the VCC website home page. Explore, think
outside of the box, and enjoy!
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Gregg Eligh: Digital People. Gregg is a good friend to
the club and well known around the club for his judging
over the years and his interesting workshops. He currently teaches continuing education photography courses at Camosun College. Gregg’s work can also be seen
in several gallery shows every year.
Rick Leche: Digital Altered Reality. Rick currently lives
in Black Creek, BC and is an avid photographer of anything or everything. He never leaves home without his
Canon gear, whether he is traveling around the world or
around the Comox Valley. Rick is a member of the Comox Valley Photographic Society where he and his wife
Donna act as mentors in photo editing.
Mike Byrne: Advanced Prints. Mike is one of the cofounders of Clock Tower Images. He grew up in Alberta’s
Rocky Mountains and has always pursued outdoor activities. As a natural extension, he produced outdoor adventure films and videos. Mike leads international photography workshops with an emphasis on wildlife.

Close-Up

.

Advanced People Digital - 1st
“Train Spotting” by Richard Webber
Judge’s comments: Excellent image showing people
in their best unselfconscious manner. Just being natural and straight forward. Good study of humanity.

Advanced Creative Digital - 1st
“Capturing Paris” by Leah Gray
Judge’s comments: It plays with one’s senses. The
juxtaposition of old and new, the faded shapes and
architectural details of old and new Paris and the image
of a solitary viewer perhaps reminiscing about history.
They all overlap and speak about some of the issues
that we are now experiencing. Well done! I also love
the splash of photographer red! Thanks for sharing!

Advanced Open Digital - 2nd
“Nets at Sunset” by Mark Sicherman
Judge’s comments: This gorgeous, graphic silhouette
carries the viewer away to some exotic, far-away location. The repetition of the fishing nets fills the colourful
sky beautifully and gives us a strong sense of depth with
their declining size. The setting sun is perfectly located
on the horizon and adds such brilliant colour to the image. The use of a slow shutter speed adds a wonderful
blur to the tranquil water.
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Advanced Theme Digital - 1st
“Surfing, in the Air” by Don Peterson
Judge’s comments: Great action shot with good focus
and composition.

Close-Up

Advanced Monochrome Print - 1st
“Temple Stairway, Toyama, Japan” by Steve Barber
Advanced Open Print - 1
“Here’s Looking at You Sam”
by Christine Hutchins Gallagher
st

Judge’s comments: This is a wonderfully expressive
image. While I generally find such symmetrical composition a little lacking, in this case it works well, very much
leading to the directness of the gorilla’s stare. The handling of the black face, slivery hair and dark eyes is excellent. Nice work!

Judge’s comments: Ultimately the true test of an image is its mood and impact. I find that this image has
those in spades. On top of that I love the light on the
stairs and the composition, they make the most of what
otherwise might be seen as rather mundane subject
matter. Great image.

Advanced Wildlife Digital - 1st
“Three Steller’s Sea Lions Grooming”
by Daniel Rondeau

Advanced Nature Print - 1st
“The Three Amigos” by Steve Lustig
Judge’s comments: I love this image. The composition
and the poses of the penguins are fabulous against a
very simple background. It’s dynamic, it’s entertaining
and has great impact.
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Judge’s comments: This is an incredible image, on par
with some of the images I recently saw on display at the
Wildlife Photographer of the Year Exhibit. I love the framing, that you took this from the perspective at the surface
of the water, and the way the two animals are coming
together with a triangle in your composition. I also love
that this was taken in perfect lighting conditions giving it
harmonious toning. Your choice of aperture means that
my eye stays focused on the animals and there is nothing distracting in the background. I also appreciate that
there is ample negative space to frame the subject. Really brilliant work!
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Intermediate Open Print - 2nd
“Winter Grasses” by Kim Smith

Intermediate People Digital - 1st
“Lumberjack Ballet” by Judy Johnston

Judge’s comments: This is a compelling image owing
to the simplicity of the scene. A well-trained eye caught
this, well done. The limited depth of field works very well
to draw the viewer’s eye to the main subject. The exposure for the difficult lighting situation has been handled
well by the photographer by ensuring that highlights are
not blown out.

Judge’s comments: Lovely creative play with light. I’m
not sure how much of this was literal and how much
was controlled in post-production, but it makes a strong,
graphic image. This shows creativity by the photographer.

Intermediate Creative Digital - 1st
“Love on the Glacier” by Grant Hughes
Judge’s comments: Another image that speaks to
me about uncertain times (subliminally?). A picture of
a modern young couple apparently contemplating life
in isolation, on a rock, surrounded by ice, with a gritty
cold background, but perhaps rising above it all to see
the full moon. Thanks for sharing!
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Intermediate Open Digital - 2nd
“Glory of the Snow” by Lorna Shaw
Judge’s comments: Strong use of colour and depth of
field in this image to accentuate the overall beauty of this
floral scene. Well exposed throughout the image, so that
no hot spots appear as distracting elements. This image
earned a well-deserved second place award.

Close-Up

Novice People Digital - 1st
“Soul Sisters” by Joanne Couch
Intermediate Theme Digital - 1st
“Hanging on Overhead” by Ian Clay
Judge’s comments: Great vibrant photo, full of action,
definitely up in the air!

Judge’s comments: A lovely, heart-tugging group portrait. Appropriately sharp focus on the girls in front of a
softer, unobtrusive backdrop focuses our gaze on the
subjects. You have skillfully taken advantage of the light
to enhance their soft skin tones and to bring out the
bright hues in their clothing. Great job capturing the trio
just at this moment with one of them looking away and
the little girl on the right looking so shy. Composition is
good. Well done!

Intermediate Wildlife Digital - 1st
“Red and Yellow Barbets” by Gita McCormick
Judge’s comments: First of all, this instantly drew me
in. The symmetry is spectacular. What an incredible
capture. I love that you keep my eye anchored on the
subjects with your choice of a wide aperture, so nothing distracts my eye in the background. I also love that
the branch leads my eye to stay on the subject. I also
think a vertical composition suits this very well. An absolutely spectacular image. I adore this.
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Novice Open Digital - 2nd
“Under my Thumb” by Ken McLean
Judge’s comments: Wow, timing is everything. The
bright gold/yellow colour draws our eye and a triangle
is formed as the eye travels between the girl’s top, the
window and the bug’s armour. Exposure and focus are
good. The image is well framed.
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Novice Wildlife Digital - 2nd (Tie)
“Beach Walk” by Wendy Clay
Judge’s comments: This a great shot of two penguins,
totally by themselves on a beautiful beach. The penguins
are well placed in the image. They are in focus; the lighting is good and there is a foreground, middle ground and
background. Beautiful colours. A story well told.

Novice Theme Digital - 2nd
“Galactic Gem” by Gwen Long
Judge’s comments: This is a wonderful shot of a challenging subject. You have captured the beauty of the
Milky Way and also managed a great composition as
well. The soft water belies a long exposure. Well done.

Editor’s Choice
An extra image selected by the Editors as there were
no Novice Print entries this month.

Intermediate People Digital - 2nd
“In the Spotlight ” by Vladislav Vasnetsov
Judge’s comments: This is well framed and composed
and your being able to catch that little pool of light is
magic. We can see these two profiles which is the minimum to make this work. Good eye here.
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Member Profile: Bob Law
My photographic journey began in my late teens (several centuries ago). My first real camera was a Praktica
SLR, an East German film camera. Next was the original Canon EOS film SLR. I used these cameras for
many years for night photography and sports car racing
photography at the old Westwood track in Coquitlam.
Family and kids became more important for about twenty
years when I shot mainly family/vacation events with a
variety of point-and-shoot cameras, including an early
Panasonic Lumix. During my 42 years as a commercial
real estate agent, I did mainly architectural photography
for advertising purposes but, in 2014, I bought a Nikon
D80 with the idea of rekindling my interest in photography in preparation for retirement. Since then I have
upgraded to a Nikon D850 and a D500 with a cabinet full
of lenses and gadgets.

“Mary Vine Falls”
Victoria Camera Club. I joined the Club in early 2016
and have been active in field trips and workshops. The
Club has proven to be a wonderful experience with an
amazing group of like-minded people. I particularly enjoy
Members’ Night to see what everyone else is doing and
how they are doing it. In 2018, to “give back” to the Club,
I became a member of the executive as Vice-President.

“Waiting for Dinner”
I am a “generalist” photographer with a leaning toward
landscape, waterfalls, cityscapes, old buildings and machinery and birds (particularly herons), plus some sport
photography such as the Swiftsure and my son’s and
grandson’s cycle-cross races. A recent addition is street
photography that I find both challenging and fascinating. I
enjoy the Tuesday field trips, the Hornby and Tofino trips,
and getting out in parks and in nature to discover new
subjects. I find becoming totally immersed in a location
or subject, such as graffiti, waterfalls, nesting herons, or
a few days at Hornby Island or Tofino gives me the greatest satisfaction and produces some of my best images.
My main goals these days are to read the light, get it right
in the camera, and to improve my post-processing skills
with Lightroom and Photoshop with a particular focus on
black and white conversion.
The best photographic advice I have received was from
Clive Townley and Steve Barber urging me to join the
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In the past couple of years, I have been entering internal
competitions, with somewhat mixed results. I think competitions are an important part of the Club and one of the
best ways to improve my photography, so I will persevere.
I look forward to continuing to be active in the Club and
bring my skills up to the level of the gear in my cabinet.

“Standing Guard”
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Outside the Box
by Greg Samborski
“What camera did you use?” “Which lens?” “Your camera settings?” We’ve all heard and, probably even asked,
these questions. While we need a basic understanding
of how our cameras and lenses work, there are far more
revealing questions we could ask such as “Why did you
photograph that?”, “Was there a reason for that angle?”,
and, “How many tries did it take?” These offer insights into
the creative process and allow us to start improving our
images without having to spend money on equipment.
Creativity is infinite and costs nothing to improve. Imaging
technology has improved at an exponential rate. It’s easy
to research which lens is sharper in the corners when an
improvement in creativity would distract the viewer from
a few blurry pixels.

This is not the time to shoot 120 frames trying to achieve
perfection so I limit myself to three frames of the same
angle/pose/light/technique before changing. Think of
this as brainstorming with your camera. You want to
come home with as many ideas as possible. There you
can axe what you don’t like and, if needed, go back and
perfect the ideas that captivated you.
“So, what should I shoot?” Well, anything! You’ll probably
feel stupid taking a photo of a Windex bottle on the workbench but then you notice a shaft of light coming through
the window and place the bottle there. Then you might try
picking it up and spraying it around with one hand while
photographing it to capture the mist. Wow! Now the mist
is back-lit by the sunbeam and the background has fallen
to shadow!!! And you’re only just warming up.

So, here’s a challenge for you when inspiration and
creativity don’t strike. I call it the One Camera, One
Lens, One Light exercise.

“Vending Machine”

“Storefront Area”
We start by imposing extreme limitations on everything
but your creativity.
Time: Limit yourself to 20 minutes.
Confine: Restrict yourself to a very small space like
a bedroom, car, section of beach, or the outline in the
“Storefront” image.
Refine: Minimize your gear to one camera, lens and
focal length.
Now, challenge yourself to capture as much diversity as
possible inside that twenty-minute window. You have the
option of making the shots completely unrelated (which
is a good way to explore options) or you can try to connect them in a more editorial, story-telling style.
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“Interesting… but really, Greg, I don’t want to take pictures of spray bottles, and the sun rarely shines here
anyway, let alone into my windowless garage.” Then
you need to choose a subject that connects with you.
Try macro shots of bugs in your tulip patch; practice minimalist shots on the smallest beach access you can find;
or document twenty minutes of your dog’s life in the car.
I adore portraiture so I frequently work with a fellow photographer, aspiring model or even a stranger for this
kind of project. I realize getting together is not possible
right now due to social distancing but you can always
work with a family member, or even your cat.
These are just a few ideas to inspire you. In closing, I’ll
leave you with the final step:
Redesign: Add your own modifications that focus on
an aspect of photography you’d like to improve at such
as limiting yourself to only shooting at night, resisting
the urge to chimp, or adhering to off camera flash only.
You can see Greg’s work at: GregSamborski.com

Close-Up

Walk Around It
by Joseph Finkleman
I was 19, just starting my career as a commercial photographer. My first job was to haul gear from point A to
point B. My employer, an experienced commercial photographer, had also been a working journalist and because of this, he was a consummate visual storyteller.

outside and use just one focal length, preferably a “normal” lens (50 mm full frame). Find the least interesting
subject you can see which is at least seven meters from
the door. Find the most interesting point of view of that
subject and take that picture. Now put the camera aside
and take the pad of paper out.

The job was an architectural image of a skyscraper. Before I was to unload the 4x5 view camera and 6 kilo tripod, he said, “First, we walk around the building from as
far away as we can get. Then we move in a little closer
and walk another circuit.” In the end, we walked three
complete circuits to find the best angle.

“People”

“Architecture”
The essence of all art forms, including photography, is
storytelling. As a trained photojournalist, I had a fairly
good idea of how to tell a story. But I didn’t know how
to fully research the story I wished to tell. This man
taught me the importance of looking at the subject from
every angle, not just physically but more importantly,
from every angle of the story.
Every subject has a complex story. During my forty years
of teaching photography, I have come up with a variety
of assignments designed to teach students how to tell
that story more effectively. I have found that most people
do not want to spend the painful time needed to deeply
learn one little aspect, then another little aspect, ad infinitum, until they have developed a deep and broad understanding of how to tell a story photographically.
Occasionally I would come up with valuable assignments
that I would never dare to give out of concern that no
one would complete them. This is such an assignment:
You will need a camera, a pad of paper and a pen. Go

May - July 2020

Draw a rough diagram of where the subject was and
your point of view; label it diagram one. Explain in one
or two sentences why you thought that was the best way
to tell the story of that subject. (This is quite difficult for
most people to do, so you have to work at it.) Then imagine every single other point of view that you could have
chosen to photograph the subject and roughly diagram
each one out. (For brevity’s sake, simplify the number of
possibilities and number each of them.)
Not only should you have at least eight possibilities at
ground level all the way around the subject but, also
eight at waist height, eye level, and drone level. Three
levels of height from ground level plus two aerial views,
times eight, plus one directly overhead, equals fortyone possible places one could position the camera.
Subtract the one you chose. Now write out for each of
the forty un-chosen points of view what reason would
have made that point of view the best choice. What
would have been the story of each of the other points
of view?
One can easily see why I never gave this assignment
to a class. However, I can guarantee that if you honestly work at doing this one assignment, you will learn
more about storytelling in one or two days than you will
learn in a decade of active storytelling.
Learning the purpose of story and also learning that
every single thing, no matter how banal, has a myriad of
possible stories is crucial to being a creative storyteller.
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Photography Projects
by Evan Guengerich
Several years ago I somewhat spontaneously decided
to begin a Project 365. In case you’re not familiar with it,
this involves taking a photo every day for a year. When
I began the project, I didn’t have a clear idea of what I
hoped to accomplish. It just sounded like an interesting
challenge, a combination of documenting my life and
taking the best photo I could every day for a year. When
I completed it, and I did take a picture every single day,
I was a different and better photographer. As I reflect on
it, I think it was a significant inflection point in my growth
as a photographer and the reasons for that are much
clearer to me now.

ideas, around 1.8 million ideas, to be more precise. The
important thing to realize is that those are other people’s
ideas of a project. Rather than using what inspires someone else, which may not be relevant to your experience
and goals, my recommendation is that you ask yourself
some questions and think carefully about what you want
to accomplish as a photographer.

“Rear View”
What type of photography are you passionate about?
Would you like to learn specific skills? Do you want to
work your way through the concepts in a photography
book that’s particularly meaningful to you? Or maybe
you would rather create a book of family portraits, a series of black and white fine art photographs or a portfolio
of cityscapes. Would you benefit from building your post
processing skills through a series of training videos? Do
you want to practice different composition techniques or
maybe document an event or period of time in your life?
Is your priority to just be more consistent with getting
out to take pictures? There is no right or wrong project.
It can be big or small and last for days or years. The

“Mule Train”
Most of us are creatures of habit. We tend to do what
is easy and habitual rather than what will ultimately be
most beneficial and fulfilling. As photographers we frequently go to the same places and photograph the same
things using the same settings and techniques. Then we
sit down to edit and move the same sliders we always
use to end up with photos that look a lot like the ones we
always take. That approach isn’t bad and will result in
gradual improvement over time, but planned and structured practice and learning can result in more transformational growth. A photography project can be a great
framework to accomplish that.
As I define it, almost any planned set of photography-related activities with a specific goal is a photo project.
You can google “photography projects” and get some
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“Lydia on the Attack”

Close-Up

most important consideration is to make it one that inspires you and helps you to move forward in your photographic journey.
After deciding what you want to accomplish you can
then put the specifics of the project together by building
a specific plan in the same way you might develop a project plan for a work-related project. List the key steps that
will get you to your desired outcome. Determine what you
need to learn and explore the resources that are available. Think about the people you will want to involve and
any travel you might need to do. Detail all the considerations and steps involved, whether few or many.
Considering the timing and pace of your project will be
important to its success. How much time can you allocate to it given competing priorities and the nature of the
project? Maybe you have a two-week period available
and decide to spend a couple of hours daily for those
two weeks. If you know your work or family schedule can
be challenging, maybe allocating time each week over a
period of months works better. Make sure the time commitment is realistic and sustainable given the realities of
your life. Plan the time into your schedule. Set reminders
on your calendar or put it on your to-do lists. Build some
cushion into your schedule and give yourself permission
to miss a few sessions to avoid feeling pressure or resentment when life gets in the way.

era every day helped me get to know it better and I
used it more intuitively and confidently. Second and
more importantly, the project helped me learn to see
things photographically.
Every day for a year I looked at scenes and objects
around me trying to find an interesting photo in the
normal and a story in the routine. I began to see those
scenes and objects in terms of lines, light, shapes, contrast and balance. Some days, when the light of summer
lasted long into the evening, it was easy. Other days,
when I went to work in the dark and came home in the
dark, it was challenging. At times I was pleased with my
daily photo and other times I had to accept a weak photo
as the best I could do that day but, by showing up for
my project every day, I ultimately finished the year as a
better photographer.

“Six Months of Sony”

“Frosty Morning on Mesachie Lake”
The biggest challenge to completing a photography
project successfully is usually having the motivation
and discipline to make consistent progress. Your chances of success will increase with proper planning but
realize that sometimes it will be difficult. You’ll be too
tired or competing priorities will intervene. Just aim for
consistent progress over time and you will ultimately
complete it.
My “Project 365” had two primary benefits for me. First,
it made photography a part of my everyday life, which
resulted in improved technical skills. Handling my cam-
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What is my current project? I’m calling it Six Months of
Sony. After shooting with a Nikon DSLR for years, I’m
moving to the Sony mirrorless system. There’s a steep
learning curve to get to the point that using my new
camera and lenses is intuitive and I can again focus
on my photography rather than on my equipment. My
objective with Six Months of Sony is to get out every
week for six months and use my new gear, explore
its capabilities and generate at least one compelling
photo each week. That will give me a strong start at
developing the familiarity and proficiency I need.
My favourite photography writer, David duChemin, wrote
in his book, The Soul of the Camera, “Mastery can’t
be accessed via shortcuts, and it takes discipline just
to stay on the path without taking the detours that are
waved in our faces.” Our lives are busy and, as we fit
photography into the spaces around other priorities, our
tendency can be to do what is easy and familiar. By engaging in thoughtfully-planned activities and structured
learning we can use our limited time to develop into better photographers. Taking on a photography project can
be a great way to “stay on the path” in our journey forward. I encourage you to give it consideration.
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How I Did It

Alter Ego
by Stephen Ban

Petals and Tendril
by Daniel Rondeau
July 17 started as a rainy day, leaving drops of water
all around my backyard. That was my opportunity to try
my new Nikkor 105 mm f2.8 micro lens.

Although at first glance, this shot looks like it was either
a multiple exposure or composited in post-processing. In
fact it was neither. It was all done in-camera!
The initial inspiration for this shoot was two-fold: first, the
movie Black Swan, which depicts a ballet dancer’s descent into madness as she auditions for a role and becomes unsure about what is real and what is fantasy.
The second part of the inspiration came from a dance
routine choreographed by Mia Michaels depicting someone’s struggle with addiction, personified.
I already knew the perfect models for the roles, one depicting the “good”, or light persona, and the other the
“evil” or dark persona, and it helped that both the models
had similar enough hairstyles and facial features to pass
as almost-twins.

The image is composed of three elements: the tendril
is all natural, the sunflower in the background is a cut
flower placed approximately 30 cm behind the tendril.
Keeping the flower close allowed it to cover the entire
background and to fill most of the water droplets. While
there were natural drops of rain on the tendril when I
first noticed them, those in the image are from a homemade solution of water and sugar. The sugar allows
larger drops of water to hang on longer.
My Nikon D850 was mounted on a tripod, required because the final image is a composite of thirteen focusstacked images taken at 1/100th sec, f11 and ISO 100.
Using the focus-stacking mode of the D850, I manually
set the focus to the closest drop I wanted sharp and
chose the number of images to be taken successively.
The camera then takes the shots, adjusting the focus
between them according to the step setting I chose. I
had to contend with a light breeze that moved the tendril, ruining several series of shots. Stopping down to
f11 allowed a larger change in focus between frames
and reduced the number of shots needed.
Individual images were loaded into Photoshop as separate layers and aligned (File->Scripts->Load Files Into
Stack, with the automatic align option selected). They
were then blended for focus (select all layers then Edit->Auto-Blend Layers, with the options Stack Images
and Seamless Tones and Color selected). The resulting
image was cropped and, only minor tonal adjustments
and sharpening were applied.
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The lighting setup was straightforward: one Flashpoint
XPLOR 600 Pro studio strobe set to multi-flash (stroboscopic) mode with an octobox approximately 45 degrees
camera left with one flash occurring each second, for a
total of five seconds, one continuous light with barndoors
as a rim light and a simple black backdrop.
I then asked Paige (in white) to grab Addy’s hands and
throw them off, with a pose change after every flash,
keeping the shutter open for the entire five seconds
(Nikon D850, ISO 64, f13, Nikon 17-35 mm f2.8 lens set
at 26 mm).
It only took a few takes to get the shot we were looking
for, and for post-processing, all I needed to do was convert to black-and-white and adjust the levels a bit. Voilà!

Close-Up

Shoots Around Victoria
Witty’s Lagoon
by Bob Law
Witty’s is one of my favourite parks that I visit with my
camera several times a year. It is a 56-hectare regional
park in Metchosin surrounding Witty’s Lagoon. The lagoon is a sheltered oasis overlooking the Strait of Juan
de Fuca, in the farming community of Metchosin. The
park is split into two main sections: Tower Point on the
east side and the larger main lagoon section on the
west, with Witty’s Beach on the extreme west side.
There are over five kilometers of forest hiking trails, never
far from the lagoon. When the tide is out, the lagoon is a
huge salt marsh, teeming with wildlife. Over 160 species
of birds have been documented in the park.

“Sitting Lady Falls”
point here), the tidal flats and to Olympic View Drive.
The Beach Trail is a forest trail that skirts the shoreline,
home to stunning arbutus trees that look like giant orange octopus tentacles that follow every direction except up and straight. There is a detour through the salt
marshes and out to the sand spit, with the main trail
terminating at Witty’s Beach.

“Witty’s Lagoon”
Tower Point: Access to this section of the park is via
Olympic View Drive (off Metchosin Rd. to Duke Rd. West
to Cliff Dr., GPS: 3934 Olympic View Dr.). There is a 500
m trail from the parking lot, through a scenic meadow,
leading to a high rock outcrop with commanding views
of Haystock Islets, Parry Bay and Juan de Fuca Strait.
There is a small beach on the west side of the point with
a rich variety of marine life in the rock pools revealed at
low tide.

Witty’s Beach: An alternative access is Witty’s Beach
Road (limited parking, go west from the main Metchosin
Rd. parking lot, over the bridge and turn left), on Parry
Bay. A steep set of stairs leads down to the gravelly
beach. A sand spit that turns in to shallow tidal flat at low
tide stretches over a kilometre toward Tower Point. It is
perfect for swimming, sunbathing and beach combing.
You will want to plan several visits to the park, there is
too much to see for just one visit.

Witty’s Lagoon: The easiest access to the Lagoon is
off Metchosin Rd. (GPS: 4100 Metchosin Rd.), where
the Nature Centre is located (open weekends and holidays 12 noon to 4 pm). The Lagoon Trail starts through
an area of large Douglas firs and Big-leaf maples along
Bilston Creek. Just down the first hill you need to decide between the 1.9 km Lagoon Trail on the left, or the
1.2 km Beach Trail to Witty’s Beach.
The 1.9 km Lagoon Trail winds around the east side
of the lagoon, past Sitting Lady Falls, Whitney-Griffiths
Point (with washrooms, basic picnic facilities and a view-
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“Gnarly Arbutus”
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Imaging the Sky
by W. John McDonald
I love the sky. When I was a kid living on a small farm
on the prairies, my older brother and I sometimes slept
outside in the summer. We had a tent but preferred to
sleep under the stars. I have never gotten over the feeling
of awe that comes from seeing thousands of stars in the
sky on a dark night.
In my teenage years I acquired a camera and soon after,
set up a rudimentary darkroom. Photography, like the
sky, has been in my bones ever since. Happily, these two
interests fit together. Images of the sky can show not only
what I saw as a child under a dark sky but much more as
the sensitivity of modern cameras greatly exceeds that
of the eye.

“Star Trails”
The next step is to add a simple tracking device that sits on
top of the tripod and can move the camera to compensate
for the earth’s rotation so that longer exposures can be
taken. Without that, the apparent motion of the stars will
result in star trails and blurring unless the exposure is
quite short. With tracking and a wide to moderate focal
length lens it is possible to take long enough exposures
to capture quite deep images that show much more than
the eye can see. It can be surprising to discover that an
object in a long exposure wide-field image is actually a
galaxy or that a patch of colour is a glowing nebula. The
California nebula seen as a bright red object in this image
is an example.

“Milky Way through the Trees”
Photographing the sky has its challenges but is intensely
rewarding. The sky is full of fascinating subjects. There
are constellations, stars and star clusters, planets, nebulae, galaxies, comets and, nowadays, even satellites
and the International Space Station.
Getting started is not that difficult and some surprisingly
beautiful images can be captured with just a camera and
tripod. Constellations, star fields, planets, the occasional
comets that come by can be photographed this way as
well as striking images of star trails like the one shown
in the next picture.
Using simple equipment is a great way to begin as one
of the key challenges for anyone starting out in astrophotography is learning what is up there and how to find
it. A good sky atlas will help you identify your subjects.
Wide-field skyscapes are one way to get to know the
sky and complement the more traditional binoculars and
charts approach that visual astronomers use.
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“California Nebula (red) and Pleiades cluster (blue)”
As you learn about these objects and how far away they
are you realize the photons that are coming in to your
camera can have been travelling for a long time. They
are giving us a picture from the past. Even nebulae like
the glowing red patch in the California Nebula image
above are thousands of light years distant. The light

Close-Up

from galaxies that we see has travelled millions of years
or more and takes us far back in time.
Once you discover how much is up in the sky you are
likely to want to go further by getting a telescope and fitting your camera to it. This kind of astro-imaging is more
challenging. The requirements for mount stability and accurate star tracking go up as the focal length increases.
Also, photographing dim nebulae and galaxies usually
requires very long exposure times. This is usually done by
combining (stacking) multiple exposures, each of which
is as long as the equipment and skyglow will allow without
showing streaking or fogging and can range from several
minutes to hours. The image shown here required a total
of 8.5 hours of exposure over several nights. Perhaps
the most crucial equipment for this is kind of imaging is
warm clothing.

“Andromeda Galaxy (M31)”
of a galaxy taken with a telescope means more to me
when I can first locate the tiny target in a wide-field sky
scape. The two images shown here are an example. The
wide-field one shows the Milky Way over a ranch house
with a small glowing patch in the sky on the left. That
patch is the Andromeda Galaxy, the most distant object
our eyes can see on a dark night. It is 2.4 million light
years distant. When imaged with a camera attached to
a small telescope the lovely spiral shape appears as in
the second image.
Our solar system has interesting targets, too. The moon
has much interesting topography to capture. For high
magnification studies of planets, moon and sun special
high-speed video cameras are often used along with
software that selects frames with the least atmospheric
disturbance for stacking.

“Bode’s Galaxy (M81)”
For me, getting wide-field images of a section of the sky
with some foreground in it to give a sense of scale is
a great precursor to seeking out the tiny galaxies and
nebulae that I capture with a telescope. A lovely image

“Planets, Moon and Sun”
I hope this brief introduction gives a glimpse of the rich
opportunities that can be found in astrophotography and
will encourage you to explore the wonder of the night sky
with your camera.

“Milky Way over Ranch House with Andromeda on left”
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For those interested, more information on how to get
started is on my website: john.astronomers.ca.

25

Beginners’ Corner: Handheld
Photography

traffic lights. Then for fun, I matched the left corners with
the center of St. Peter’s dome and the embankment’s
edge. It worked and I left, happily with my camera.

by Josée Ménard
As photographers we are all advised to venture out with
our tripod. It is an essential tool for a sharp image unless
you mean to creatively introduce camera movement
into your composition. I am often out without my tripod.
Why do I dare? Because I often shoot candid moments,
street photography and wildlife. As you will read there
is more to handheld photography than bracing yourself.
First we need the basic handheld grip. Slip on the camera strap. Place your right hand on the right side of the
camera with the index finger at the ready near the shutter button and the thumb near the top right corner. The
remaining fingers hold the right edge. Some cameras
provide a molded bulge (grip) to guide them. The index
finger and thumb work the buttons. The left palm supports the left side of the camera. The fingers hold the
lens barrel while the index finger and thumb work its
rings and buttons. How do you master this? Practice. Instead of reaching for snacks at commercials, reach out
for your camera until holding it becomes natural, then
add practicing with the buttons and rings.

“The Vatican Over the Tiber River”
The second requirement is your stance. With feet shoulder-width apart, straighten your back, relax your shoulders, and ready your camera. Elbows tucked into your
ribs, exhale, hold it, gently press the shutter button. If
you need more support, creatively transform your body
into a tripod leg. For example, stabilize further by leaning
against a wall, a post, or a tree. Sit or kneel and use your
knee(s) to brace against it. You can position the camera
on top of your backpack or the trail-mix bag on top of a
rock. You might risk it all on the parapet of an old bridge
in Rome as I did when I captured the Vatican in between
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“The Vatican At An Angle”
With the basics out of the way let’s get technical. Depending on the exposure needed, increase the shutter
speed or the ISO. The higher the ISO, the less light
you need. Test your camera noise production at specific ISOs to know how much is acceptable to you. For
lenses, a favourite is a 50 mm wide-aperture prime
for images in low light. Primes are usually faster while
zooms may need a slower shutter speed or higher ISO
to compensate for their slower aperture. For portraits,
plan for a faster shutter speed and spot focus on the
eyes to keep them sharp. For landscapes, maximize
the depth of field with an f11-18 aperture. Increasing
the shutter speed can improve acuity.
For sharpness, play it safe. Unless you mean to creatively introduce camera movement set the shutter speed at
or above the lens’s focal length. Thus, for a 50 mm lens,
keep it at or above 1/50th second and so on. Do not forget the crop multiplier (i.e. 1.5x, 2.0x etc.) if your camera
has a crop sensor. Lastly, do not forget to set the image
stabilizer to “on” to reduce vibrations.
Handheld can be great for panning and blurring the
background while focusing on a moving target. Set shutter speed priority and track the subject in the focus frame
until it passes you.
Lastly, it has been a pleasure to contribute to the Beginners’ Column for the past three years. Now it is time
for me to pass the keyboard along to another volunteer
writer. Enjoy your photography!

Close-Up

Anywhere You Want To Go,
We Can Help You Get The Shot!
Beau Photo Supplies
has been proudly
supporting passionate
photographers for
over 30 years.

We are an independent shop with personalized service that can’t
be found online. Our staff are also photographers and between us,
there is a wealth of knowledge for you to beneﬁt from.
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